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Using Dreamweaver 

7 – Frames 

One of the later inclusions in the HTML standards was the Frames capability. Frames were 

originally introduced by Netscape for version 2 of their Navigator web browser and later 

adopted with some additions by Microsoft for version 3 of their Internet Explorer web browser. 

Frames finally became official when the HTML 4.0 standard was finalised. 

Frames allow you to display more than one HTML file within the same web browser window. 

Each section of the screen is referred to as a frame. The technique is normally used to aid in 

website navigation. A website that uses Frames will have several HTML files. There will be one 

HTML file which contains the information about how many frames there will be, how big they 

will be, what pages will appear in each frame etc. There will also be a separate HTML file for 

each frame in the site, plus HTML files for any additional pages that may need to open when 

links are clicked. Take a look at the example below. The HTML used to create the frameset is 

shown to the right. 

Navigation Main Page <FRAMESET COLS="20%,80%"> 

   <FRAME SRC="navigation.html" NAME="nav"> 

   <FRAME SRC="main.html" NAME="main"> 

</FRAMESET> 

In the above example, one HTML file would contain information saying that there is a frameset 

with 2 columns. It would specify how wide each frame is, along with which two HTML files 

will display in each frame. That makes three files in total, plus any pages that will load if the 

user clicks on links. Since a frameset can only divide the page in to even columns or rows, if the 

web developer wants their page divided up in a less even way, it may be necessary to have a 

frameset inside another frameset like in the example below. 

Heading  

Navigation Main Page <FRAMESET ROWS="100,*" COLS="*"> 

   <FRAME SRC="heading.html" NAME="heading"> 

   <FRAMESET COLS="15%,85%"> 

      <FRAME SRC="navigation.html" NAME="nav"> 

      <FRAME SRC="main.html" NAME="main"> 

   </FRAMESET> 

</FRAMESET> 

Tip Since Dreamweaver can handle most of the details about the frameset for you, it’s not necessary 
to know the HTML, but it can help, especially if you run in to problems. For detailed exercises on 
HTML for frames go to http://oneil.com.au/pc/html/HTML-6-Frames.pdf 

http://oneil.com.au/pc/html/HTML-6-Frames.pdf
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Exercise 1 –  Creating a Frameset 

Before you begin these exercises, make sure you get the Frames exercise files from 

http://oneil.com.au/pc/dreamweaver.html. These contain the HTML pages that will be pieced 

together in our frameset. If you don’t have them, you’ll need to create pages from scratch to be 

used in your frameset. Make sure these files are all saved on your computer. The frameset you 

create will need to be saved in the same location when you get to that part. 

1) Open some of the exercise files in Dreamweaver to see how they look. 

We will create a frameset that places a heading page (heading.html) across the top of the screen, 

a navigation page (navigation.html) down the left side and several other files to be displayed in 

the man frame area. A style sheet (styles.css) is also provided to control the formatting in the 

main pages while the heading and navigation pages use inline styles for their formatting. 

2) From the File menu select New or press [Ctrl] [N]. 

 

3) From the list of categories select Framesets (in some versions – Page from Sample and then 

Framesets). In the list of framesets, select Fixed Top, Nested Left, which is one of the more 

commonly used frame layouts. Click Create. 

Dreamweaver will create a page that has 2 framesets. The first frameset divides the page in to 

two rows. The top row is 80 pixels high by default with the other row taking up the remaining 

space. Within the second row is another frameset which divides the area in to two columns. The 

left column is 80 pixels wide with the other column taking up the remaining page. Some 

temporary blank files are being displayed in each frame currently. We could edit and then save 

each of those blank files but instead, we will select existing files to be displayed in each frame. 

4) The first thing we will do is save the frameset. From the File menu select Save or press  

[Ctrl] [S]. Enter index.html for the filename and make sure it is being saved in the same 

folder you placed the frames exercise files in. 

5) For the Title of the page enter Dreamweaver Information.  

http://oneil.com.au/pc/dreamweaver.html
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6) Hold down [Alt] and click in the top frame. This will make the frame’s properties visible in 

the Properties panel. 

 

7) Review the explanation of the Frame properties on the next page and make the changes 

indicated (and shown in the example above). 

Note If the frame borders are not visible in Design view, go to the View menu, select Visual Aids and 
then select Frame Borders. 

This frame will be used for a 

page heading 

This frame will be used for 

page navigation 

This frame will contain the 

site’s main content 
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Property Purpose Change To…  
Frame Name This identifies the frame. If the user clicks on a link on your 

page, you can direct the linked document to load in this frame 

by referring to its name. 

Heading 

Src Specifies which HTML file will appear in this frame when the 

page loads. You can use the Point to File icon  to select the 

file just as you can with hyperlinks 

Heading.html 

Scroll Specifies whether a scrollbar will appear in this frame or not. 

Setting it to no will prevent a scrollbar from appearing. Setting 

it to Auto will mean a scrollbar will appear whenever the 

content of the frame won’t fit in the available area. 

No 

No resize When this option is ticked, the website user will be unable to 

resize a frame by dragging its border. 

Ticked 

Margin 
width/height 

Controls the amount of blank space around the edges of the 

frame. Leaving it blank will mean a small amount of blank 

space will appear around the inside edges of the frame. Setting 

it to 0 will remove any margin. 

Leave blank 

Borders Controls whether the frame will have a visible border. No 

Border color Colour of any visible border around the frame. Leave blank 

 

8) Hold down [Alt] and click on the left frame. 

9) Set the frame’s options as shown below. 

 

10) Hold down [Alt] and click on the right frame. 

11) Set the frame’s options as shown below. 

 

12) Save the changes. The completed frameset should look like the example on the next page. 
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Exercise 2 –  Customising a Frameset 

1) Click on the line that divides the top frame from the bottom frames. 

 

You could drag this line to change the height of the frame, but doing it through the Properties 

panel allows for more precision. Now that you have clicked on the dividing line, the properties 

for the frameset should be showing in the Properties panel. 

2) In the properties, enter 60 for the frame height, making sure that Pixels is the measurement 

used (You can also specify a size as a percentage of screen height). 

 

If you click the bottom frame from the preview in the properties panel (as indicated above), you 

will be able to change the height of the bottom frame. Currently it will be set to take up 

whatever space the top frame leaves. We’ll leave it on that setting. We won’t make any changes 

to the width of the bottom 2 frames. 

3) Save the changes to your frameset. 

4) Check the code view [Ctrl] [`] to see what HTML has 

been used to create your frameset. 
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Linking in Frames 

When your page uses framesets then links may need some additional information to specify 

what frame the new page is supposed to load in. Hyperlinks can be directed to certain frames by 

using the Target attribute. A list of possible options for the target attribute in HTML anchors 

(links) is shown below. 

Target Result when link is clicked 

Target name 

E.g. ‘nav’ 

New page will load in the frame of that name. If no frame of that name exists or if the 

frame name is mistyped, the new page will open in a new browser window of that name. 

_blank New page will open in a new browser window. 

_parent If nested framesets are used, then the new page will fill the current frameset. For example 

in our page, where the bottom two frames are part of a frameset, a link in either of these 

frames using the _parent target will make the new page fill both frames of the frameset. 

_self This is the default option if nothing is specified. The new page will load in the same 

frame as the link that was clicked. 

_top The new page will load in the whole browser window instead of a particular frame. 

Exercise 3 –  Creating Links with the Target Attribute 

1) Make sure the frameset is still open in Dreamweaver. 

2) Select the text Home in the left frame. 

3) Create a hyperlink to the file home.html. 

4) Preview the page in your web browser (save the changes first if prompted). 

5) Click the link you have created. 

6) The new page loads in the current frame by default. Go back to Dreamweaver and click on the 

link so its properties appear in the Properties panel. 

7) Change the Target property to main. 
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8) Create links for each of the other items in the navigation bar so that the text Requirements 

links to requirements.html, Features links to features.html and Resources links to 

resources.html. Make sure that each link has the Target property set to Main. 

9) From the File menu select Save All. 

10) Preview the site in your web browser. 

11) Click on each of the links to test them. Each of the pages should now be loading in the right 

frame (main). 

12) When you click the Features link, notice that there is too much text to fit in the frame (unless 

your monitor is set to a very high resolution) so a scrollbar has appeared for that page. 

Scrolling down the page will only affect that frame with the heading and navigation still 

clearly visible. This is one of the advantages of using frames for navigation. 

13) Click on the Resources link in the navigation frame to load the resources page. 

14) Click on one of the links under the Resources heading. The new page will load within that 

frame. 

When you are linking to a site outside your own, it is better for the new site to fill the whole 

window rather than being squeezed in to your site’s navigation. The other page will look better 

and most likely be more useful, plus it’s generally considered inappropriate to force your 

visitors to keep your heading, logo etc when they decide to follow a link to someone else’s site. 

We’ll add the _top target to those links so that they load in the whole window. 

15) Return to Dreamweaver and open the document resources.html. 

16) Click on the first link. 

17) Change the Target attribute for that link to _top and do the same for the other links. 

18) Save the changes. 

19) Return to your webs browser and reload the site (or preview it again from Dreamweaver if 

you no longer have it open in your web browser. 

20) Try the links in the Resources page again. This time the links should load the new sites using 

the whole window. 

Advantages and Disadvantages of Frames 

Many people don’t like Frames. In a large number of cases, this is simply because they’ve been 

to too many websites where frames have been used badly, such as frames with links that don’t 

use the target attribute properly. Below is a list of what are commonly regarded as some of the 

advantages and disadvantages of frames.  

Advantages 

 Static navigation, such as navigation bars 

will always be visible. They don’t get lost 

when the user scrolls down a page. 

 Logos, messages etc can also remain 

visible. 

 Some designs are easier than other 

techniques (such as tables) using frames. 

 Graphics used in navigation, heading 

frames etc only need to be downloaded 

once rather than repeatedly loading for 

each page. 

Disadvantages 

 Search engines may not be able to index a 

frames site properly. 

 Individual pages in a site are harder for 

users to bookmark. 

 Older browsers or browsers for people 

with disabilities may not support frames 

(see the next section for tips on dealing 

with that problem). 

 Frames sites can be difficult to edit since 

more than one HTML file is involved at a 

time. 

 Framed websites often don’t work too well 

on smaller screens such as on web enabled 

phones. 

Remember that page layouts that can be done with frames can often be done just as well without 

them. It’s worth thinking carefully about whether you can really benefit from using frames 

before basing your website around them. 
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Exercise 4 –  Adding No Frames Content 

Some browsers don’t recognise frames. One way of catering for those browsers is to create two 

versions of your website – one with frames and one without, then you can create a main page for 

your site that that provides links for the user to go to the version of their choice. If you don’t feel 

like going to such lengths, there is another way to provide for the browsers that don’t support 

frames. HTML allows for a NOFRAMES section of the page. Browsers that recognise frames will 

use them and ignore what’s in the NOFRAMES section. Other browsers that can’t handle frames 

will ignore them and the content of the NOFRAMES section will appear in the browser instead. 

1) Make sure your index.html frameset is still open in Dreamweaver. 

2) From the Modify menu, select Frameset and then select Edit Noframes Content. A blank page 

will appear representing what non frames compatible browsers will see. 

3) Enter the following content. 

 

Dreamweaver Information  
 Main 

 Requirements 

 Features 

 Resources 

 

 

4) Each of the items in the bulleted list should be a link to the appropriate page and the first line 

should be a level 1 heading. 

5) From the Modify menu, select Frameset and then select Edit Noframes Content to return to 

your normal view. 

You won’t be able to preview the NOFRAMES section unless you have a browser that doesn’t 

support frames. You will be able to see the NOFRAMES section in your HTML code. 

6) Check code view [Ctrl] [`] to see the NOFRAMES section that has been added to your 

frameset. In the example below, the NOFRAMES section is highlighted. You may need to 

click on the border between the frames before you switch to code view, otherwise you may 

be seeing the HTML for one of the files that appears within a frame instead of the HTML for 

the frameset itself. 
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Inline Frames 

If you’ve been wondering why we keep checking code view when editing HTML isn’t 

necessary with a WYSIWYG editor, now you’re about to see that is sometimes is necessary. 

Other times it may not be necessary but might just be handy. Inline Frames are potentially a 

useful features in websites but unfortunately aren’t supported too well in Dreamweaver. This 

means that there’s no easy way to add one to your site other than to do it through HTML. 

An inline frame allows you to add a frame that you can position on your page just as you would 

position a picture, rather than dividing the whole page in to frames. When Microsoft introduced 

support for Frames in version 3 of Internet Explorer, they included Inline Frames as an 

additional use for frames. When Frames became part of the HTML 4 specification, inline frames 

were included also. For a long time few browsers other than internet explorer supported Inline 

Frames even if they supported normal frames. These days though, inline frames are fully 

supported in the most popular browsers such as Internet Explorer, Firefox and Opera. 

Inline frames are created in HTML using the IFRAME tag. The tag has a number of attributes 

that are similar to those of a normal frame such as another frame (in case links elsewhere on the 

page need to load a document in the inline frame) and other options for borders and scrollbars. It 

also has some attributes that are very similar to those of the image tag such as height, width and 

alignment for positioning the inline frame on the page. Anything placed between the opening 

<IFRAME> tag and the closing </IFRAME> tag will appear in browsers that don’t support inline 

frames. 

Exercise 5 –  Adding an Inline Frame 

1) Open the requirements.html file in the editor. 

2) Go in to Code view by clicking the button  or by pressing [Ctrl] [`]. 

3) Add a blank line after the closing tag of the heading (</H1>) and before the opening tag of 

the unordered list (<UL>). 

 
<H1>Requirements</H1> 
     Create a new line here 
<UL> 
 <LI>800 MHz Intel Pentium III processor (or equivalent) and later</LI> 

 

4) On the blank line, type the following. The SRC (source) attribute specifies which file will 

appear in the frame, in this case it will be mac_requirements.html. 

 
<IFRAME SRC="mac_requirements.html"></IFRAME> 

 

5) Save and preview the page. If it looks something like the example below you know it’s 

working. 
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6) Try scrolling in the frame. 

7) There is a link at the bottom of the Mac Requirements document (Mac Tips). Click on that 

link and another document will load in the frame. 

8) The last link in this document goes back to the Mac Requirements document. The other 

three links that are arranged in a bulleted list all go to other sites. Each of these links uses the 

_top target so they will load in the full window, just like in a normal frame. Try one of them. 

 Now we’ll go back to our frame and edit some of its properties. 

9) In the HTML, right click anywhere in the IFRAME tag and select Edit Tag <iframe>. 

 

Dreamweaver might not support IFRAME tags so well in design view but the support in code 

view’s good enough. 

10) Complete the options for the tag as shown below. 

 

 Tip If you click on Tag info in the bottom right corner of the Tag Editor, the window will expand to 
show a section at the bottom that explains each of the tag’s options. 

11) Click OK. 

12) Save and close the file. 

13) Open index.html in the editor and preview it in the web browser. 

14) Use the navigation bar to get to the Requirements page so you can see the inline frame. 

15) The completed site with the Requirements page showing should appear like the example on 

the following page. 
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Exercise 6 –  Revision Questions 

1) For each of the following Frameset layouts, how many HTML files would be needed? 

 

 

  

 

 

  

 

 

 

   

2) If your website uses frames for navigation, what are two things you can do to make sure the 

site’s content is available to people using any browser? ______________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

3) Describe two good reasons for using frames in a website. ____________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

4) Describe two good reasons for avoiding using frames in a website. ____________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

5) Describe two ways that an inline frame might be used in a website. ____________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 __________________________________________________________________________  

 


